Using Feature Phones to Promote Literacy
and Scripture Engagement

Cynthia Trotter
SIL Chad

We really like SIL’s Reading App Builder, Scripture App Builder, and the new Bloom Reader
app for Android smartphones. We have used them to create and convert many books. But
there is one problem: many of the people in the language communities in Chad do not own
an Android phone. Yes, some day Android phones will be more prevalent, and their
numbers are growing, albeit slowly. But we are interested in what we can do with the
phones many people have right now: feature phones.
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We have discovered three workable options: (1) easy reader video books, (2) Go Bible, and
(3) PhotoBible. You might find them useful as part of your literacy and Scripture
Engagement strategies.
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1. Easy reader video books

It is possible to create a narrated easy reader book
for a feature phone (which can also be played on an
Android phone). What you are creating is a little
video that includes a line or two of text for each
picture.

A great source for Bible story pictures is:
https://freebibleimages.org or the video templates
or pictures available through SIL International
Media Services:
https://www.internationalmediaservices.org/bible-
story-scripture-video-templates.

A word about the choice of pictures: feature phones
have very small screens so the pictures should be
simple without a lot of detail and with good
contrast. Photos like the one in Figure 1 are ok
because it is simple. Photos like the one in Figure 2
are not as suitable because the details are lost on a
small screen.

After testing, we found that the black and white
drawings were the easiest to interpret and the black
text with white background was the easiest to read,
as in Figure 3. It is true that using black and white
images does not exploit the use of a phone which
displays in color. But the goal is ease of reading and
easily interpreted pictures. If you have more than
two lines of text for the picture, it would be better
to make a duplicate slide and put the additional
lines of text on that slide, rather than reduce the
font.

The video is created by using the video export
feature of PowerPoint. First, create the slides,
choosing the standard slide size (4:3) which displays
correctly on a feature phone, and add a line or two
of text to each picture. If possible, keep the
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minimum font size to not less than 66. A font any smaller than that is challenging to read on

the smaller feature phones.

The purpose of these videos is to help weak or new readers to gain fluency, so the text
should be limited to one or two lines. Insert a separate text box for each portion of the
phrase. Breaking the phrase down into parts is what reading theory calls “chunking” and is
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helpful to new readers. This will enable you to
highlight each text box for the narration. The slide
in Figure 4 is made with three text boxes and the
first is highlighted.

Once all the pictures (slides) with their texts are
prepared, go back and add an animation feature

to each slide. Select each text box (not the text Jee kaam t:):)kge tu dIO

but the box) and add the animation Fill Color. You tDDCf t:>:>y metn Isa ki
can define the color under Effect Options (see )

Figure 5). We suggest a fill color of yellow or
orange.
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Once all the animation features are made, you are now ready to narrate the video. Go to
File and Export your presentation as Create a Video. Choose the option Record Timings and
Narrations. This will open your presentation in slide show. Go through your presentation
activating the animations and narrating as you go.

To verify your narration and timings, go back to Use Recorded Timings and Narrations and
choose Preview Timings and Narration. You can re-record individual slides by selecting Slide
Show > Record Slide Show. Then select either Record from Beginning or Record from
Current Slide. If you click on the play button at the bottom of the slide, you can check the
recording for individual slides.

Once you have previewed the timings and narration and are ready to create the video,
choose Create Video.

PowerPoint will export the presentation into a MP4 format which can be played on an
Android phone. To play the video on a feature phone, you will need to convert the MP4 file
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into a 3GP. You can use a free program, such as Format Factory
(http://www.pcfreetime.com), to convert your video to 3GP.
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As with any literacy or Scripture Engagement materials, it is important to test the video on a
real phone with several people in the community, making any necessary revisions before
widely distributing. In addition, the final page should include copyright information, e.g. the
same as appears in the Bloom book for Android.

2. Go Bible
Wikipedia describes Go Bible as follows:

Go Bible is a free Bible viewer application for Java mobile phones. It was developed
by Jolon Faichney in Surf City, Gold Coast, Queensland, Australia... Go Bible is
installed like any other midlet by copying the .jar and .jad file to the cell phone by
USB or Bluetooth.?!

The Go Bible is already published in many languages including English and French. These and
others can be downloaded from the web. You can also create your own Go Bible in your
project language with Paratext.

Your Paratext program must first have the Pathway software installed. The Pathway
installation is available here: https://software.sil.org/pathway/. Once that is installed, you
are ready to create your Go Bible. For Paratext 8, from the File menu, choose Export to
Pathway, follow the choice of which books to export and then choose Go Bible when you
choose the Destination. For Paratext 9, the Export to Pathway option is under the
hamburger menu for each translation window.

Once the files are created, a pop-up window informs you that the two Go Bible files (.jad
and .jar) are created and you can open the file destination (folder) from that window. From
that folder in your computer you will need to copy over the .jar and .jad files into your
phone in order to install the Go Bible. The Go Bible app needs both files in order to run but

! For even more information on the Go Bible go to https://en.wikipedia.org/wiki/Go Bible#Go Bible site
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opening either one will install the Bible on your phone. After that you should find an icon for
the Bible on your phone as an app or it may be under the JAVA icon.
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If you get lost and cannot find the files on your computer, they should be located under
C:\Documents\Publications\NTKF\Scripture\go_bible 2019-12-11_141919. NTKF is the
name of our Paratext project. You can also find them by doing a search for “Go Bible” on
your computer.

Special characters in Go Bible

It may be that special characters will not display correctly on your phone. Getting them to
display correctly is dependent on the phone, the characters used in your language and the
font. Your Paratext consultant may be able to help you to arrange the Paratext files so the
font works for the phone you are using to run the Go Bible.

Here is the method we have used in Chad where in one language, the glottal stop ' appeared
as a box and the tilde on the n did not display correctly under the n. (see figure 8)
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Figure 8 — Uncorrected font,
with some characters appearing as boxes

To create a copy of a Paratext project which will display special characters better on feature
phones:

Open your project in Paratext.

Go to the Project menu and choose Manage Books.

Choose Copy Books.

In the To Project either choose the previous one or click New.
If you chose New, then create the project.

When you have the project, click Select All Files.

Click OK.

0 N o 0k~ W N E

Now you can make the necessary changes to the copy of the project using Edit >
Replace.

In this case, after creating a new project, we selected all the instances of ' (a straight glottal
stop or apostrophe) and changed it to a normal apostrophe. For the n we selected all those
instances and changed them to fi. For some phones, the implosive letters will not display
and will appear as boxes. If this is the case, you might need to experiment and choose
another Unicode character in the Paratext project. As you can see in figure 9, certain letters
appear as if they are in a different font, but the text is still readable.
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Figure 9 — Corrected font, with special characters appearing
(although sometimes as if they are in a different font)

We have found that even after correcting the font and testing to see that it displays
correctly on a certain brand of phone, another brand of phone still might have problems.
We have found this to be true with the implosive letters. If you have the time and access to
these different phones, you could experiment to find a solution that might work for all the
phones. Even so, when we have transferred a Go Bible to someone and the font does not
display exactly correctly on their phone, it is still readable, and they are pleased to have it.

An interesting feature of the Go Bible is that you can copy a verse and send it as an SMS
along with any comments.

To share the Go Bible from your feature phone you will need to send both the .jar and .jad
file via Bluetooth.

3. PhotoBible

Most of the inexpensive phones available in Chad do not run Java so they cannot use the Go
Bible, but they do display pictures, videos and have a memory card slot. An option for these
phones is the PhotoBible
(https://lingtran.net/JPEG+Scripture+Publishing+for+Simple+Phones).

PhotoBible is a conversion of USFM Scripture files into .jpeg files, 2-3 verses at a time. The
first step is to upload your Paratext files to the Bible Drop Box site (http://freely-
given.org/Software/BibleDropBox). The usual upload is the back-up zip file of your project. If
you only want to create a PhotoBible of certain books, those which have been consultant
checked, for instance, you could create a separate back-up zip file and use that instead of
the complete project. The site then converts them into .jpeg files (photos) of 2-3 verses. We
found the upload process very simple, and even possible in the village with a slow internet
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connection. After you upload your Paratext files, you go back to the site about 1-2 hours
later and download the PhotoBible zip file(s) which are available on the site for 14 days.

A New Testament is 150 MB and an Old Testament is 350 MB. Here is what the files look like
on an inexpensive phone in one of the languages of Chad that has a screen size of 3.5 x 4.5
cm.
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Figure 10. Each book has a folder, and sub folders for each chapter
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Figure 11. Each chapter is a JPEG picture file: 01.jpg, 02.jpg, etc.

With this size of screen, the text is very readable. A screen any smaller than this is difficult to
read.

Distribution of a PhotoBible can be a challenge. Feature phones do not support zip files, so
the picture files can only be shared by Bluetooth one at a time. Alternatively, the folder with
all the photos can be transferred via cable to the phone from a computer, or the PhotoBible
can be shared by memory card.
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Conclusion

We hope that this information has inspired you to try creating a video reading book, a Go
Bible, or a PhotoBible. Even a feature phone can be used to promote reading as well as
listening to Scripture!

We would appreciate hearing from you on how you have used these ideas or for any
suggestions or ideas of how you use feature phones in your area for literacy and Scripture
engagement.

Please feel free to contact us at: cindy_trotter@sil.org
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